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20U 228l 284 OMR WaAsHI 24 s H (A) O, (B) O, (C) O,
(D) O [aseadl 2uden 8. d -l 2 gaet Al iy d- [Aseq ur-
Ao Uetefl yel sa1-l 8 el. w1 WAL & 100 UL 8. €35 Us-L 1
301 282 ety WAl $_AFua 9.

1) Al FUR SAR oMl U © U d 541 G esi-l oA € 7
(A)  stueudl 2 [Bréer
(B) n[20ye 2 B
(C) e A [BHdl
(D) main () method 1 $252R

2)  SULDBAA A AU HAI - A SARN AR $UL MSIR-L

oy A 9 ?
(A) A-kind-of (B) has-a
(C) A-part-of (D) is-a

3) U2 - set-l wala s s 2sAw@A (Exception) #l 52 €9 ?
(A) File Not FoundException (B) ArithmeticException
(C) IOException (D) NullPointerException

4) R sdl [Qseu s 2185 i) 241 1M 92+ (Untitled)
Qoo sufd ¢ ?

(A) Edit mode 244112 (B) slHe 2¢oiir - 1
(C) A2 - AR (D) Page pane
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6)

7)

8)

9)

10)

11)

gctiml el s (Primitive) 3212154 81y €9 7
(A) 2 (B) 4
(C) 8 (D) 16

‘AoiB2’ Bl Hi2el A2 dws@r sdl ¢ 7
(A) submit () (B) function submit ()
(C) onsubmit () (D) onclick ()

DAl 56 A, AU sl sl Rgal x4 waud str (6% 52)
Ul 81U, dl true U 5369 7

(A) boolean compare To (String str)

(B) boolean equals (String str)

(C) int compare To (str String)

(D) int equals (String str)

AlA-unigl syl [asew ule scnefl, s¥ulzzul yaed(luel
(Selection List) GHY asiy 9 7

(A) Insert — Selection List (B) Form — Selection List
(C) File > Selection List (D) Edit — Selection List

UYL - 2l AL sl auid, dALH wAsA A 112 9] A58

elg A ?
(A) Field Value (B) %41, L™ (Group Name)
(C) Field Selected [Asey (D) Initially Selected [Aseu

R Al Al sl [Aseuw uaie 53U Al 211Eq
s19e ot-udl wsd 7

(A) Archive (B) Compress

(C) Extract (D) Back

AL 2] ARl oget 2 suL usi-l ogd eald © ?
(A) swdd sl auid GgHadl eyd

(B) Ha eHuA Geotadl epa

(C) aa-l o

(D) sl o
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15)
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Al2A-niel su) [Asey 21 5185 ALssA 2lo% el -l o1l o A1
Ale @ sdiAl AMALL sal Ml s AdAle vy ¢ ?

(A) uBul (B) dllei[Ean
C) leudes | (D) se

-

532 [Qautel &, AlA-unigll sl iz sald © 5 WAl
suisa sid s 2w Al ?

(A) ExitCode: 1 (B) ExitCode: 0

(C) ExitCode: -1 (D) Exit: 1

sl usR-l s19e 2L s19e &l WS 69, ¥ sslsdl Huadl sy,
gl & U - Ad s19e, WA $19a xnal [QARARL s ?

A) [gigl s1de (B) 252 519e

(C) 3% s1de (D) (A), (B), (C) d* ™

szl [Q=siAi, 232 HLs 2dotinl sl [aeidl uR (sas sael
SlAMl oirlad s1HAL AlAsleA A sl © ?

(A) Design (B) 115{(&2{*1 (Preview)

(C) Source | (D) Normal (u4)

12 salad 23 sedl yals Budi-l Asts 531 us ?

intmarks|[ | [ ] =new int[4][4];

(A) 8 (B) 64

(C) 16 (D) 4

11y 2ed -l dotiide www.ircte.co.in L S-51HAAL UL U51RAL
[AlRloLd Gelse © ?

(A) 2l dldt €AW (Online Auctions)

(B) FZlL 4 dawel (Marketing and selling)

(C) Rl A (Information Services)

(D) ALY Aalil (Support Services)
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21)

22)

23)

24)
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doitsdei [Es-l -1 521 Hi2 5L [Aseu wie sl 204 © ?
(A) Insert > Link (B) File > Publish
(C) Insert = Hyperlink (D) File > Upload

Y13 SIH Ao HE sl 20, AR d-{l [l s1L @A Hisadl
9 d R 5l HI2 form g2sl 59 clalBisdil Guylol saMi
19 8 e dll BHd d3 d g dlsR 69 ?

(A) ugld (Method). Get (B) usgld (Method), Post
(C) Action. Get (D) Action. $19d- k!

sidaMi yals, sl (double) »1ql 0[&dn (boolean ) Fal A, H13
% {10952 A1l M2 s1L USR] s1da-Al Gualol 53 sy 6 ?
(A) 2% 519d (B) $¥lsz 5194

(C) 3% s19a (D) oudzl 5164

(lAAHil su1 20U QA IDE -l Heedll PHP. Rails, Ruby %
web ML ML s ol asiy o ?

(A) HIML (B) og[usi-
(C) L (D) tel-l [l
Al 55 S - siHA/AH SIHAAL YRaL vivd ([Ad1idlA ous

N

sl YA L 8§ 7
(A) OLHdl (B) vil3cdl
(C) H[asddl (D) SR-wRdls1R

AAAiell 3 [Qud s19a - seud dloy uofs [t ol ?
(A) File (string path)

(B) File (directory path)

(C) File (string directory_path, string file_name)

(D) File (file directory, string file_name)

{lAAiel 531 U517 [ANUard GUAlaLsAl Beulen i Al

23l [t HURdl yIL u ¢ ?
(A) ¥oig (B) LML
(C) 419y 3u3AL UHl (D) [Add

331(G)/B Page 4



25) Al 5O Aul, Has sld sl RRatAl 2idHl WA str Al
L&A GHIA 2oL vllose ud 53 69 ?
(A) stringtoLowerCase() (B) stringto Upper Case ()
(C) string concat (string str) (D) intlength ()

26) ~(lA-uiell sul [aseu A58l yaqyl (G2B) ulaglasd
GelswL &9 ?

(A) www.irctc.co.in (B) www.incometaxindia.
gov.in
(C) tradeindia.com (D) amazon.com

27) BUURL 532422 YRl dotgle UR SIOEll @UIAIdEL H12 FTP -l
Buulal sdl avid (1Al 56 [Qaudl 2uudl #3316 ?

(A) derjlded M (B) &4 -l v
(C) Yo 2 Yiuad (D) ugld (Method) clalBLsdi-l (51

28) ~{lA-waiell 56 cglisil greuwvl Add elsd & deudel o
qIREL 531 IR 5369 7

A) (=32 (B) &9l
(C) &M 518 (D) AUeR %3AU[EUd

29) GG 2o s HRAHL sUL vllo% sl vieR AotUAAL dHIH 1Y
gesl FAl 3 1, Rl [Es 21 iy g2l -] vl & ?

(A) Location (B) History
(C) Parent (D) Document

30) sclt-l ottl Oe-A-l AR stqell suL 32t s34l w9 ?
(A) €lu (heap) (B) JVM
(C) duoly sAser garbage collector (D) e~y

31) Al su1 3 4} VLC HIRurdu: 93 s31 asiu e ?
(A) Media — OpenFile . ..
(B) Media — Open Directory . ..
(C) Media — Playlist
(D) Application = Sound & Video
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32)

33)

34)

35)

36)

37)

38)

(LAl 59 @i 2R At qeuddl [AsiyAl, Ulcies
AeAil, gsiHl Ass-{l o0 Fal Gelswll ¢ 7

(A Husdl vy FEa-aai (B) [Astiud gl Hleiis-

(C) ¥Us2sl Al (D) g[5a Al

(A uuiyl sul

UAHL 20 9 7

(A) 5252 (B) loyse

(C) seuy (D) 3a

LAzl su1 el - selrAl GUAloL WA dval Hi2 21y ¢ 7
(A) letter (B) article

(C) book (D) beamer

doildeHl sal Uil HRdl slell 331 & ?

(A) QA% HIMAL d@ll 2 GUNMLHL vqale s3]
(B) A 24 [Argd

(C) Aysl 24 Youd

(D) (B) 2 (C) ot

oo 518 Hus A5

ol

(A) sy HUs (B) clse Ay
(C) vy Hug (D) Alus wus

Table Properties SI4@ll 6l 54 Ml sl [Aseu Ae gl zou [F[2id
sl M Gualall & ?

(A) Size (B) TableAlignment

(C) Spacing (D) Padding

(LRl su [Qui--l

(BHd urd 52 69 7

(A) return [QtuA (B) If[Qtu-
(C) a2 dwer (D) 2ude dMId
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40)

41)

42)

43)

44)

45)
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53 seA-{l 59 wagld wedl-l 2ls ud 53 69 7

(A) intnextlInt () (B) String has Next ()

(C) Stringnext() (D) boolean has Next ()
AR 56 Aaa@s UaslA Srerne uR Al ay dal 16 e ?
(A) C2B (B) B2B

(€)' €2C (D) B2C

LAl sul [Aseuni sl s 5 % AR sl 218 oL

69, d et dld vARelcd HAD €9 i ML A0UAS SN VoSl
514510 AR sl sl 4dl el ?

(A) HdReu (B) A3t
(C) WliEnH (D) 3L - AR25AUA

AU WA 54 52U Geulert, el - el ALl 012 A6iAd
st AL, dla-tdl Wladly (Qedue v dig--l wdslaul
oietaal-{l uatall »ul & ?

(A) ud @i Rae (B) QA Wl YR
(C) ud @i He (D) LU

A2SAHL $UL SHLws uedlAi oui o uswll wRRrel a3 axsal
Ud €9 A % 5% Quid 20| ws1y 97

(A) \ setcounter (B) \tableofcontents

(C) \'mainmatter (D) \appendix

AL - vedL ALl 5% AHAL geL - gel el aHdl 3
AR g sdauni vud 9 ?

(A) 2haralla (B) a3

(C) 3u3nvil (D) RAAL¥a

gul UsIR{l MLIAFHDL eUNL ALFedRAL ViU GRLHAL SI3HL WA

UelALRAL AR HlYgaHl 381 sl 5 oeadl(l AHAdL A d
AR AARisdl ol 69 ?

(A) uBuwid wafFHa (B) <1UR dad HauoL iy
(C) lose 2uRd MWBRL (D) “C 3BRL et
ST
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46)

47)

48)

49)

50)

51)

52)
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Ra - es-2ui e - Yeladl-l (31d dal case Bud o AH A
HA dl sul [QaAl 2a 0wy 9 ?

(A) break (B) continue

(C) if ....else (D) default
Aa=12531b=72eddla%bxi Au-l [(54d g «a ?
(A) 1 (B) 5.3

(C) 5.0 (D) 1.22

{la-uniell sur usiR-l dorude el - el w51 vitdizil, (@l
s dlo il dal ARUR S GUULR(] 245 UsIRAL 2RUASL
Al MRl yILud 69 ?

(A) G2B (B) G2G
(€) G2C (D) B2C

Yusar-ll display () Hausa Swalls sal He-ll wloy aisy -
sS8?

(A) display () ' (B) display.super( )

(C) super.display () (D) show.display ()

SLSURL 532 ML 6L Yo (oL suL suLe9 ?

(A) [QEY w1 sidugla (B) el v 2iul

(C) 343uil u stdugld (D) el i s1d

AAiY] sul [@Qseu A4l 2t A2 8, ¥ 3estiAl HawR Y
5389 dal [Q3diA edda-l udiaz 52 ¢ ?

(A) Syl a-s (B) sauRaL o5

(C) A (D) AA-23de -4

(lAiedl sut yrau Guanl d vidl 2wl © % qreudl
Heedo(l [Qadl Aarid Ad AAUA] © 2t -Agd @lsd d-ll
gudloL 53 asal Al ?

(A) SR (B) Rlse uEBi2
(C) uisdlsw (D) wallise

331(G)/B - Page 8



53)

54)

55)

56)

57)

58)

59)
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SLOUHL 26LOU UM 21 WAL HRdL 2522 ol syl sl wedl
sy ol UR (548 sl sl e ?

(A) Signin (B) Login
(C) New User (D) Enter Skype

Calendar 5@+l MONTH »3d Hie R R BHd g
sluew?

(A) 12 (B) 1

(C) 11 (D) 0

2145 yarui AlA-uniedll syl [Asew, caa-l [Qasaim 2d
HI2 HEE3Y ol 89, % AUl [ASIRAHL, GAlle-dl ALRIHL 2
AlssiA oteloll AvarHl 2sNaHl veL Hee3yw Au ©§ ?

(A) SRR (B) Aoiulsde

(C) Aal¥se (D) HTML

AR 59 wgla siiladl uReun-l 1ol Assy @3y
AAl oeHIoL @l HIZ GUdlal Ay © ?

(A) Console printf(String format, Object args)

(B) Char read Password ()

(C) Char read Console ()

(D) String (Object args)

AAAHE 531 USIRAL HARAXAHL Gedten-{l YA 2= Guaoy
Yol (AN Ate s sl 20l s 9 ?

(A) UYL HAAUY (B) © - slvd
(C) ¥d - a4y (D) YA dHIH

{lAsidl s d2su sHIm gL edldxHl culblas Rg- ‘e’
WH s asi 9 ?

(A) \subset (B) \in

(C) \notin (D) \nea

(ARl sUL 5L GIAL Al dMIM AU UR HIRdAHE o MBUL
sUHL 209 © FYL A il wala © ?

(A) HIReR 518 B) 518

(C) ©-d&e (D) 3 -4 (RuPay)
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- 64)

SFO97

65)

osulY S5 AGLHIOU (string) A AL[PUS 3uMi 3aal M2+l MUt
S3AUML G AL 5UL USIRY Vs Ggord 9 7

(A) Arithmetic Exception

(B) Null Pointer Exception

(C) Printer 10 Exception

(D) Number Format Exception

A+l GulaL uedl Aoty wuRad-lle g ], uig GualaLsdl
AL Adle, 6B, [REdxel x4 HTML (Qaidl-l aulaslla
(dynamic) Al {12l sla-ll e s3 a3 9 7

(A) AuRse (B) CSS

(C) HIML (D) SRR

s dlds 2uual 2l Heading-1 el {ld-umial sul
2aolRHIY] Ye saUHL 2 © ?

(A) siHz 2¢0R - 1 (B) sl¥2 za0uz -2

(C) s¥BuA 26 (D) W2AOUR

A il su1 Aag sladl A4 sl 2L vt 20 A2 ©a
% calendar sl calendar U652 &1y dl ?

(A) calendar.get (Calendar.DATE, 20)

(B) calendar.set (Calendar.DATE, 20)

(C) get. calendar (Calendar.DATE, 20)

(D) set.calendar (Calendar.DATE, 20)

6L sl A HridRe-A ealaal e sul gl Gualor iy © ?
(A) vudl dlug R

(B) ciiddl €l Rg-

(C) Yusaudll Aoisal drs Mg s3d dlR

(D) uotsendl Yusald ds MEw s dlR

LR o2t %l S 82s ABY ol R ARl 56 serl Gged & 7
(A) Seled (B) focus
(C) Click (D) mouseover
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67)

68)

69)

70)

71)

72)
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{lA-iell suL [@Qewat “UAsAUA St 58 8 ?
(A) try [Qeuat (B) main ()34
(C) Catch [Qeudy (D) Throw [aei1d1

Adunidl 56 cqqs ulagle vicdld dal wdd ada
Rl 922 gy WReRldIA 51200 ay stfamdl U 53U wsu O ?

(A) C2C (B) C2B
(C) B2C (D) B2B
(A - 425 (Input element)-ll 55 @laRLsAL GHRAMI vAE AR

Gualotsdl A& ealaain oled 2aRd 2l AIUHL JUidReL
5269 7

(A) Password (B) Checkbox

(C) Text (D) Reset

‘(185 215 usR-AL Alsd 87, 21 asy ARG sl GelseL e ?
(A) ARt (B) HrdRexy

(C) ol - Aogsa (D) dridydalrt

sUL USRI Mi2sA-l GUULL S5 AOLSALYA AsAA 5L Ml
2yl “friend” a3

QY 69 ?

(A) wdde (B) ulcas

(C) U (D) M58

~(RAisll sl [Asey WiR(B1s Bl 1AL 22 ot el 32 Y 6 ?
(A) int marks [3] = new marks {90, 70, 77},

(B) intmarks[ |]={90,70,77};

(C) int[ ]marks={90,70,77},

(D) intmarks [ ]= {90, 80, 70, 60};

{la-uniell sdl
sl RpoL 20052 oirud 69 7
(A) string (string literal) (B) string (char literal)

(C) string (string strobj) (D) string (charary[])
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73)

74)

75)

76)

77)

78)

79)

CSS Al - sl aud, A 615G~ a3 A=l Gualdl s:el
Hidldl €15 ol Image [Aseu-i a1 ote U [sas 53 o15uB=s
Hiel s19e uke sl w0 9 ?

(A) Opacity (B) Position
(C) Tile (D) Choose File

‘IR HLs2A™HL A A UHIBLAL SHLIRS $HHL 2L 2ALd dl
uReux g »ud ?

>a 10 >b ¢« 30 >a % b
(A) ®d otdlasl (B) 10
(C) 300 (D) 40

CTANG Y3 uH g ?

(A) Comprehensive Tex Architech Network

(B) The Comprehensive Tex Archive Network

(C) The Computerized Tex Archive Network

(D) The Comprehensive Tex Archive Numerology

YL WIULL
U5 A s ?

(A) dlBus (Global) (B) w14 (Local)
(C) dnd (D) W[2a

Lo g2 vloval Hi2 Auldl clgBisdi-l BudA g seaxi
21 €9 ?

A) leldes (B) 34l

(C) we (D) si{usudl

Atniell sl s detriions UEAL A A B i el
Yoy ¢9 ?

(A) A<>B (B) A#B

(C) ANOTB (D) A!'=B

Date sald-l 56 Has, WAdHl vUa [Qda 11yl Guala 53
Al d1Zlv oA AHY A2 519 7
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81)

82)

83)

SFO97

(A) void set Time (long elapsed Time) -
(B) long get Time ()

(C) Date (long elapsed Time)

(D) Date ()

54 U AL 20322 Ao - HRAANRWAAL LS A5[ASL AL vieaHL
wel viLss dorisendl AL s3I0 wastd dg AW Hr2333 Yl uidl
25 ALeLys QAL ?

(A) 1AL (B) oqusi+
(C) il [l (D) $MBR

AalRse Hie Al sy [Quid ac 9 ?

(i) selwe ol qauneddl ustat 1 Guylell 6.

(ii) exctldaHi wesi-l Aelld asld 52 9, d-{l [Addid el
(iii) a1l GuylaL uedl dotuar uRad-alla g .

C(A) ML (iii) (B) HUaL (ii) 2t (iii)

(C) ™=t (i) A (iii) (D) (i), (ii) d™L (iii) d¥™

SLH{HL 2R Wil S usl arg UR (545 sl »Ud 8, AR
dd Mo sui salaarHi »ud ¢ ?

(A) s*UUDart 2aoR (B) slde 2¢ouR - |

(C) RRALUR (D) sz gdouR - 2
il ) [@Qseu k.

, ‘A’ ‘B’

(i)  A2sAML awd~ as () \ (ds2dq)

(ii) A5 A2 Rt (@ [] (AR 5i)
(iii) @25t sHit-ll a32idd Qe (r)

(iv) A5 sHL=s-i asleys (s) %

YA 511
(A) (i) > (3), (i) = (@) (iii) > (p), (iv) = (1)
(B) (i) = (1), (i) — (s), (iii) = (p), (iv) > (q)
(€) (i) = (p). (i) = (1), (iii) = (q), (iv) > (5)
(D) (i) = (@), (i) = (p). (i) = (1). (iv) > (5)
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84)

85)

86)

87)

89)

ARl Brugl uBBus ueladl A next =N % 2 ==0)? (N/2) :
(3* N+ 1) ; Sld v %4 N =7 ¢l dl next A+l g Fud 2ud ?

(A) 22 B) 7
(C) 35 (D) 0

CSS -l atsua-ni, Rsaiaq Qoo (Al 9l 2 uda
scUMi 219 ¢9 ?

(A) HTML u2%

(B) HTML 825 %12 Asvudd ¥
(C) A 23y Bud

(D) @3 (B) 1 (C)

Al A4l 21Ha 5SS Hertl (event) gl Al AlAs13HY]
olletaatmi 20 (called) IR seUHL 201A B 7

(A) Function B) w4

(C) de-l (D) If [Qu

s - ldl sie ealaal we sun Rg-l Gualor iy  ?
(A) /*..*/ (B) /**. *

(C) / (D) \

o7

(A) wsde (B) M5

(C) uloys (D) U¥%

Al Al Gualol seuel dorudedl -t 35Ul 214 stfan
o ¢9 7

(A) AuRsw ~ (B) CSS

(C) HTIML (D) Java
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91)

92)

93)

94)

95)
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(Al sy [Quit arua,

[l duA 6914l 59 Switch [Qaurnl vid ugdli udai [ Gur
[Faiataue Reuntid 2 9 7

(A) continue (B) default

(C) break (D) for

‘list” AL oL @esl BHd 5 ad eial W2 il sy [Qun
Yy ¢9 ?

(A) Sort (list, 5) (B) Sort (list, 1, 7, 5)

(C) fill (list, 2, 6, 5) (D) fill (list, 5)

il s [Qouol Adl YAl €1 & 5 ¥ vs 5 ay
2udlel-l Gga aa & 69 7

(A) throw (B) throws
(C) finally (D) try

UML -l A3l ARoyel arsuauxi sat sl sl
audl ouotd-dl Bud auanasdia asuadl w3 ¢ ?

Aa) {3} - B[]
(HFs > D) ()

A U Y, AU §5d 32l [FHd alaal o uaAa(l 2uval
529l U dl 58 HA AUl ASu ?

(C) void (D) retum

ol try [Ae19L SIS vuale A4Sl A% 2 di 2115 Catch [Ae19L
CRTCIRCN

(A) dMHAL AHE U

(B) Mot 6iuslad HUM AHAHL 20199,

(C) ¥su8L Catch [Qe119L 1AL 2uQ4l Al

(D) MU=l H¥H Catch (AL HAML 2149
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96) 54l AWlEs uBus R yelael-l (Fudl »1e0l - 21edL (one true
and one false) S14 dl % true Ud 53 € 242l false Ud 53 6 7

(A) XOR (B) OR
(C) AND (D) NOT

97) «{lA-nidl sdl [Asey Al - visl v Yoy Gereel el ?
(A) OXFF7A (B) OX39A2
(C) OX 532D (D) OABC

98) 5uL USRI ARAGLIA ) M 5% USR] U2sIAl AN % 5l UA

¢ ?
(A) -l (B) ®e
(C©) aluy (D) A3 (Array)
99) flA-uniell 54l Rseu 3 ¢ - Saad-ll Hulel & ?
(A) uRad-0 ulasi (B) el Wy
(C) gusd (D) LA AHY 24x7 {2+l
UUIR AL

100) d25u- 5y W% exctidadi MU 518 GHRAL e GuylaHi

Ay & ?
(A) easylist (B) amsmath
(C) geometry (D) listings

EYTX
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1)

2)

3)

4)

3)

SFO97

Java H Yleh FA19 QE=7991 1A © ) ) 4 fieras a9t 82
(A) HFRM IR AN
(B) attributes 3% behaviour

(C) afteme i ged
(D) main ( ) method 3 FIZFX

TEAT R THAHIOT HATT- 3 classes & o149 H I | SHRGR S
g2

(A) A-kind-of (B) has-a

(C) A-part-of (D) is-a

Writer class % methods # |1 37aTR %heh T §?
(A) FileNotFoundException (B) ArithmeticException
(C) 1OException (D) NullPointerException

KompoZer ® frefafaa & @ &9 @1 fases = fag ot virds sk
(Untitled) 3991 g1 872

(A) Edit Mode Toolbar (B) Format Toolbar-1
(C) Site Manager (D) Page Pane

Java fd? o1 321 YRl 1 GEEIT IRH HIA § 2
(A) 2 (B) 4
(C) 8 (D) 16
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6)

7)

8)

9)

Submit ST 1 3= Tocl D § ® H g2
(A) submit () (B) function submit ()
(C) onsubmit () (D) onclick ()

frefafea o @ = 9 goel! I 7 6 B, IR ST St SR et
&7 str & T 82

(A) boolean compare to (string str)

(B) boolean equals (string str)

(C) int compare to (str string)

(D) int equals (string str)

KompoZer & fAefafad & § sF-@1 foswhey 782 39 W Selection
List %! e &2 Tha § 2

(A) Insert — Selection List (B) Form — Seclection List

(C) File = Selection List (D) Edit —> Selection List

Ia g9 @ 521 o fAain o §, a8 9sft wwnfaq 370 & fau =0

O g1 Afee?

(A) Field value (B) @™ (Group name)

(C) Field selected fasey (D) Intitially selected fascyq
2

HET )

(C) Extract (D) Back

11) W 8 aed A Jfe ) w9 waR 6t Jfe g o 22

(A) FURT HId GHI AA Tl qfe
(B) T & 9T 3717 archt qfe
(C) afewet =t Afe

(D) R Afe
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12)

13)

14)

15)

16)

17)

frafafed § @ Fi9-m fasey fafire awgei & g &t 9t gmr=
gfawneii & sraatu & foy T T gurm €2

(A) 9sfq (B) =g&qa

(C) SAwIES (D) T

FrR fagm & & J FF dl T T € fF Forgeed yfwma ahea
TeT g ©7

(A) ExitCode: 1 (B) ExitCode:0

(C) ExitCode: -1 (D) Exit:1

Y G TR T THR &1 221 e ¢ 9 foh 929 Tadl &, 94 6 @
- FIeH, TUTH T 1 TArhYT RIZA?

(A) AT A (B) T wia

(C) 35S ®I3e (D) (A).(B) 3R (C)Tn fasrey

KompoZer &t fa=81 &, Edit mode toolbar &% ®[ & & R faa=
FA | anft g e w1 6 @i = oft <@ Tehd 2

(A) fe9124 (Design) (B) YoIG¥H (Preview)
(C) drd (Source) (D) ™™ (Normal)

4 feu T W (Array) § foher quifes w91 1 FEE ffm <1 gt
€7 intmarks[ ] [ ] =newint[4] [4];
(A) 8 (B) 64
(C) 16 (D) 4

WG T &1 www.ircte.co.in 399132 3-FHHd & sF 4 fafqam &
IE §?
(A) TR e (Online Auctions)

(A) Insert — Link (B) File > Publish
(C) Insert = Hyperlink (D) File = Upload
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19)

20)

21)

22)

23)

24)

4 ®H ) fR T W egEn € 99 S S SHEK wel Sert
7z fafde &7 & fau F9-0 Wisge %1 398 g1 © 3R 39h Jod
(value) & T H 1 a1 & ?

(A) 9sfa (Method). Get (B) Usfd (Method), Post
(C) Action. Get (D) Action. file &1 H

fQ YR H B2 & ITGM int, double, 31¥€T boolean YR &
aftwae, W 3R object ) Fiferd w3 A BT ]2

(A) R B (B) FEISR ERT

(C) 30 FRE (D) WAL FrEH

frAfafea @ %19 9 3i9= W IDE &1 3991 PHP. Rails. Ruby =
web B IRASHISA (projects) 1 i &3 § 9 974 €2

(A) HITML (B) BlueGriffon

(C) Amava (D) Aptana Studio

frefafed 3 @ =17 @1 e fasi a9l 4 ST A w87
(A) T (B) 3r&feaq
(C) wferepyor (D) R-ufem

frfafad § @ =13 91 File 9% Class &1 37F Constructor 781

2?2

(B) File (directory path)
(C) File (string directory _ path. string file_name)

(D) File (file directory. string file_name)

frefafaa 9 3 ferg yer =t favga IwErEdied &) 95e | IR
AR Fanafi F faaro St fawga TR 93 HEdt @2
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25)

26)

27)

28)

29)

30)

frefafed § @ 19 91 Y1 37Em 2Haen {80 #@ s d 9w
SirgeRt g : Tyl fgdn s < &2

(A) stringto Lower Case ()  (B) stringto Upper Case ()
(C) string concat (string str) (D) int length ()

freAfafad 8§ @ = 91 fases TR @ AR (G2B) Aied 1 38
g7

(A) www.irctc.co.in

(B) www.incometaxindia.gov.in

(C) tradeindia.com

(D) - amazon.com

YA FPGH Y A9 B2 T A 99 & faw FTP &1 STam 3d € a1
freAfatea & @ 31 SHEE S g2 ]2

(A) I H AH
(B) Fd THI it &
(C) user name 3¥R password

(D) Sfd (Method) TI=gZ =1 4o
frefafeg § @ R @ a1 | ST difed JeaRe A eH-<A &

T 379 SIT9eR! gAY =faa 1 Joeh <! Y9 9aM &1 WA FAT 62 -

(A) f&afen (B) ¥fem

(C) gyiEATgul @i (D) HIZS FeiLl

FRR AT TS & FI A 3Teelae & F d99d & Tt 3979
32 for o, 389, feid 3 3133 3r9ga wmfae g €2

(A) Location (B) History

(C) Parent (D) Document

T &9 & G4 instance T HEIY HFEITR T ¥ 3 IR H
g1 87

(A) Heap (B) JVM

(C) Garbage Collector (D) Instance
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31)

32)

33)

34)

335)

36)

37)

frofefgs § A FH A T VLC Hfe orR T 9 g §7
(A) Media > Open File. ..

(B) Media = Open Directory . . .

(C) Media — Playlist

(D) Application = Sound & Video

frfafaa 3 @ FFR-91 WH afia 991 &, dfad fagmm, 1=
G2, U M H TR &1 g 3NfE 380 g2

(A) g1 = T e dand (B) faama w=Er=ta (WER)
(C) IMEFHE T (D) T Sand

fefafed § ¥ #1 91 fa%ey gea: Java ¥ YRIVE &2 (AT 9
Haferd) & & foAw sarn T 82

(A) HEa™ (B) sz

(C) =™ (D) 9gfd (method

Frctfrfes & @ 9 @ GeEs a1 o T de fm ¥ e
[

(A) letter (B) article

(C) book (D) beamer

a3 ¥ fHT YR H THHRT Wine gt afew?
(A) 3T e 3iR 3= o B srgarfaa i g2
(B) T3 3R fagga

(C) vl 3R Herg

(D) (B) 3 (C) 2

19 @13 methods foRet ©& fAfe=d object T ®@ &7 =1 3T object
1 geqferd a3 ol IQ T FEd 72

(A) Class method (B) Local method

(C) Instance method (D) Global method

Table Properties STaAM dfed & w1 4 faswed &1 I7M I &
S e e w3 fer 2N 27

(A) Size (B) Table Alignment

(C) Spacing (D) Padding
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38)

39)

40)

41)

42)

43)

44)

frefdafas 4 4 fFg faum &1 w9 wam &) fewfea 23 @ a8
AR fafde gem zram?

(A) return &ZH= (B) If¥&H=

(C) TA= TN (D) ITE gt

ThHT FATE 1 HE-T method 3T 21 ST T2

(A) int nextInt () (B) String has Next ()

(C) Stringnext () (D) boolean has Next ()
frefafad ¥ 9 forg TR & =R Aige 1 20 T Tod s91el @
(A) C2B (B) B2B

(C) C2C (D) B2C

frafafea § @ ®1 | fagkes ¥ aam 1 ofas Fom8 & e
a7 Y H 1N 1 Feohdl & AR T FATY o ool i FRFHIS,
Hfereh & g1 fuffa 7 g 872 _

(A) fauaa (B) THAH

(C) g& (D) 21 3

WA T Fl 1A T STHT 3z, fafu= Wi | Fafa waf &
e foieh 1 SR 2 2, TR R TR 22 1 Ferver A
3R TH Mo TR FA § 2

(A) WA == fara (B) WA @H 3R

(C) WA M ALl (D) w@13Y

LaTex ® g saTms & a1 377 it Tameama 9w & 39 91 S ©
3N Fad T TR 37N &2

(A) \setcounter (B) \tableofcontents

(C) ‘matnmatter (D) \appendix

AT 37N Geof | 37T AT =S| ! Ueh 1 ATH 1 ht &7 ol
1 Hgd §?

(A) FrATATEn (B) e

(C) FIS1 gr&d (D) G &
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45)

46)

47)

48)

49)

| 50)

SFO97

51)

fore WL a1 FIIfHT T i o 31=3 Wl B g&qam oy fom wigga
I TSI AT LA F H G B Q A eAad <t 82

(A)  IfshaTeas JrnfEm (B) TR A Wi 9t
(C) ITiae & grIAfET qrar - (D) ~C* WnfHT 9w

Switch aTel H 2R I Ud case HIF § o1 T T SR FIg HA
T Fo@ & A+ W faur frnf=g @ §?

(A) break (B) continue

(C) if....else (D) default

FRa=1253Mb=72%da%bHA & % I H 7F F1
BIT? ,
(A) 1 : (B) 5.3
(€) 5.0 (D) 1.22

freafafaa & @ fag yar =t agaee fafvy= g fawm, fafi=
FHTHR e, AR gr A e 91 am fafvy= smagA

T NfE & o1 H SRRl S FHidt & ?
(A) G2B (B) G2G
(C) G2C (D) B2C

%14 @ 919 1 3991 superclass &1 display ( ) 9&fd #1378 %4
% ferg 9 72
(A) display () (B) display.super ()

(C) super.display () (D) show.display ()

et ot Frgex wom & fore ) ot a9 FH-FH A 8?2

(A) $RME AR FrEvsha (B) ¥ 3R g

(C) wrey i wrfggfd (D) &1 3R G
freAfafed 5 @ 19 91 fasc T F=< €, I g a7-33 TewH
IR =Y & oI 47 oh! =7aen W@d €72

(A) T Sk

(B) fardita geen

(C) WX

(D) JTaM Ya9-gR (Payment Gateway)

331(H) /B Page 24



52)

53)

54)

55)

56)

57)

freafafaa & @ a1 @ e 375 78 gfAfeae #@ © 6 St @
el 51 gifard ® 3R qEafadi #:1 19 @ W R?

HEE ,
(C) et (D) waEfaaR

Y T TR S § @hIgY A9 3R THaE 7 % 918 i 9 924 W
T e S &2

(A) Signin (B) Login
(C) New User (D) Enter Skype

Calendar class % MONTH feeri® & foru fegm=r 5e1? &1 99 &
¥,

(A) 12 (B) 1

(C) 11 (D) 0

frfafea o | #17 1 fasey sTore AR &1 g & 9 w&qd
F H GETIAT AT ©, TAW, I b fasht 3R 9t g & et

I ARG HA B ot TR HLAT 8 ?
(A) KompoZer (B) I=ERe
(C) “afere (D) HTML

fAafafed & @ #H | method &1 394N fEu T format f&m 3k
A= 1 STAN H T =1 fZ7 F Console fae ©X o
H fofan ST 872

(A) Console printf(string format, object args)

(B) Charread Password ()

(C) Charread Console ()

(D) String (Object args)

= fEu e faereq ¥ @ ford TR & AR # TR IR g 3R
ITTS HATA & TEAT § AN ¢g Tohdl © 7

(A) YRYE =ANR

(B) 3-&AR

(C) Ta-=HHd

(D) (A).(B) 3R (C) @t famey
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58)

59)

60)

61)

62)

63)

- (A) Format Toolbar-1

frafafaa # @ %1 91 LaTex w918, &S B 1foda ydte ¢ ' 3ar
27

(A) ‘subset (B) \in

(C) \notin (D) \nea

frfafas 3 9@ 1 A 1S 1 STEM FWR Q T4 d9-39 &1 wrdam?
WA & X St STQT, 3HIAT AW &Y &1 S ?

(A) TR FTS (B) &S
(C) s-dg3n (D) ¥4 (RuPay)

¥ U FdT o1 & T gER H agen &1 YIS #d € 99 A
HYATR TN &2

(A) ArithmeticException

(B) NullPointerException

(C) PrinterlOException

(D) NumberFormatException

foreR I9aI T AFUS SATR1 &L deh R 8T W, iR ITArTeRdl
& 1Y a1 §a15, fE=w, nfaeia HTML &1 fawaasg a7 & fag
HIFET e T Tha & 2

(A) JavaScript (B) CSS

(C) HIML (D) KompoZer

Hd 1 ¥ <7 & faw Heading-1 =R 9 fSU 70 R -9 @R
T THS HI et B2

(B) Format Toolbar-2

(C) Composition Toolbar (D) Status Bar

3R Calendar class =T Calendar 9 object ® @1 F=ffag w4
1 e TRE § 20 HH 92 HM?

(A) calendar.get (Calendar.DATE. 20)
(B) calendar.set (Calendar.DATE. 20)
(C) get.calendar (Calendar.DATE. 20)
(D) set.calendar (Calendar.DATE., 20)
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64)

65)

66)

67)

68)

69)

gl classes & s o fa@d (inheritance) f5g foeq @ Sama a1 82
(A) f &R #= e

(B) RER =1 faeA

(C) superclass ¥ subclass & feen & sman gan @R

(D) subclass ¥ superclass @1 fgem & ST gan R

& 929 N HgAq RIS a1 €, 1 1A G 921 Hed gt 872
(A) select (B) focus
(C) click (D) mouseover

frafafga & 9 fg® ‘ sar gdu®’ (Exception handler) &@1
Sl 872

(A) try <l (B) main( ) 9sfd

(C) Catch =t (D) Throw =Alsh

frfafiaad 9 @ &9 @1 =r gz e R geet & &
1feres gREf¥Ta 1 At 241 & 3R wftomraey aifue gemar e
gt B2

(A) C2C (B) C2B

(C) B2C (D) B2B

3TYE AT 1 HHA W FFT <39 fFY YA & TF W A3
TRy § ®Tdfd a1 8 ?

(A) Password (B) Check box

(C) Text (D) Reset

‘ﬁwwwmwﬁa%’ﬁwmm%?

(A) TEAR (B) favsd
(C) =1 HgdA (D) W&
e 7N,

fseTeh
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71)

72)

73)

74)

75)

76)

frefafea o @ S @1 fawey yifys 5[ & @19 W (Array) &I
fyd &3 & fore wet 727 872

(A) intmarks [3] =new marks {90, 70,77}

(B) intmarks [ ]={90, 70, 77};

(C) int[ ] marks = {90, 70.77};

(D) intmarks[ ]= {90, 80, 70, 60};

frcifafad o | +19 91 FIZII T string object &1 FHi0 Fa &
S o smdR= ¥ feuw e wfszs (literal) &1 object H W1 872
(A) string (string literal} (B) string (char literal)

(C) string (string strobj) (D) string (charary[])

CSS & T Hid THY, 3R IHURE<S § 3HY W@ 9-d g, al
Image fa#eq & &7 ¥ 924 R fooTe FF dFuR~8 & fau v«
THE T Tl © 2

(A) Opacity (B) Position

(C) Tile (D) Choose File

R Tiea=R & 99 fu T FHie FAHER <3 € @ 391 = ufomm
gIm?

>a ¢ 10

>b « 30

>a *b

(A) TTewd! femmen (B) 10

(C) 300 (D) 40

CTAN &1 QU 98 1§ ?

(A) Comprehensive Tex Architech Network

(B) The Comprehensive Tex Archive Network

(C) The Computerized Tex Archive Network

(D) The Comprehensive Tex Archive Numerology

o g9 et =i & Afteas &l Sifvd d € 9 o8 fHg g
AfTEe Fgom 772
A) Afaw (B) T

(C) <= (D) gFuafdd
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77)

78)

79)

80)

81)

82)

egall @t Y= F g, it % g %1 39Em Qe €, 39 g
T FEd § 2

(A) A FIeE (B) ST WTEY

(C) =Eq (D) dYsfd

fAefafad 5 @ 1 a1 fasey g s ae 51 A 3R B 99 J&f
g, & fauama 82

(A) A<>B (B) A#B

(C) ANOTB (D) A!'=B

Date A & F14 W Goell, 379 % §9G 1 ITAM HJ gL TH
object % I 7E IR 5§ q95 T2 FA ©?

(A) voidset Time (long elapsed Time)
(B) long get Time ()

(C) Date (long elapsed Time)
(D) Date ()

HH Gl Sd Y TA gl 3THY & 1Y 9 qeTqd i 9
TS & TR H TR dha) I F JAEIHA & a1 s Ja9Ee
T &t Al AR

(A) Amaya (B) BlueGriffon

(C) Aptana Studio (D) KompoZer

SrafeRw (JavaScript) % fau fARfafes & @+ @ faum aw ®72
(i) SIR= 9IS I A (validation) F&H FHIA@T € |

(ii) IETES H 3ggq] & ITFH 1 G FHIAT1 § 7 fob ST favgagg
@]

(iii) ITH ITE FA B Faiw feer 7€ ®”Im)

(A) fa (i) (B) fa (i) 3 (iii)

(C) fadk (i) 3R (iii) (D) (i), (ii) 3R (iii)

wd § 99 &9 g8 H fed off i W oo 3@ ¥, 99 39 B
(structure) el W Yefa ETa1 &2

(A) Composition Toolbar - (B) Format Toolbar-1

(C) Status Bar (D) Format Toolbar-2
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